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An archaeological earthwork survey by LiDAR study for land off Station Road, Hilary 

Bevins Close and Main Street, Higham on the Hill, Leicestershire (SP 379 956). 

 

Matthew Beamish and Patrick Clay 

 

Summary 

An archaeological earthwork survey by LiDAR study has been prepared for David 

Wilson Homes by University of Leicester Archaeological Services (ULAS) for land 

adjacent to Hilary Bevins Close, Higham on the Hill, Leicestershire, (SP 379 956). 

The survey was undertaken to address a planning condition in advance of the 

proposed residential re-development of the site, which is currently under pasture.   

Previous desk-based assessments and geophysical survey (Clarke 2012; Clarke and 

Clay 2013; Richardson 2013) identified the remains of well-preserved earthworks 

pertaining to medieval ridge and furrow. 

The archive will be deposited with Leicestershire Museums as part of Accession 

Number X.A114.2012 

Introduction 

In accordance with National Planning Policy Framework (NPPF), Section 12 (Conserving 

and Enhancing the Historic Environment) this document outlines the results of  

archaeological earthwork survey by LiDAR study, at Hilary Bevins Close and Main Street,, 

Higham on the Hill, Leicestershire (NGR: SP 379 956). The assessment was commissioned 

by David Wilson East Midlands Ltd from University of Leicester Archaeological Services 

(ULAS) in advance of the proposed residential of the site, which is currently under pasture 

and used for grazing. 

The village of Higham on the Hill is located approximately 3km to the north-east of 

Nuneaton and 4km to the north-west of Hinckley, close to the Leicestershire-Warwickshire 

border (Figure 1). The assessment area is located in between the disused Ashby and 

Nuneaton Joint Railway Line and Main Street, on the eastern side of Station Road, adjacent 

to Hilary Bevins Close (Figure 2).  

The assessment area consists of three fields covering approximately 3.5 ha of land, lying at a 

height of c. 110m aOD. The Ordnance Survey Geological Survey of Great Britain Sheet 156 

indicates that the underlying geology is likely to consist of Wolston Sands and Gravel 

overlying Mercia Mudstone. 

 

Desk-based assessments have been undertaken for the area (Clarke 2012; Clarke and Clay 

2013). The Leicestershire & Rutland Historic Environment Record indicates that this site 

contains well-preserved Ridge and Furrow earthworks, which represent the upstanding 

remains of medieval and post-medieval agricultural cultivation. Ridge and Furrow 

earthworks are a characteristic feature of the Leicestershire landscape and are a diminishing 

resource.  

 

The Senior Planning Archaeologist, Leicestershire County Council has therefore requested a 

survey of the ridge and furrow earthworks prior to the levelling of the ground. This has been 

secured by Condition 11 of the planning permission (P.A. 14/00503/FUL). 
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Figure 1: Site location 

 

Reproduced from the Landranger 140 Leicester area 1:50000 map by permission of Ordnance Survey on behalf of The Controller 

of Her Majesty’s Stationery Office. © Crown Copyright 1996.  All rights reserved.  Licence number AL 100029495 

 

Figure 2: Location of assessment area east of Station Road and Hilary Bevins Close, Higham 

on the Hill (supplied by Hayward Architects, 50m Grid) 
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Ridge and Furrow 

 

A survey of the preserved medieval ridge and furrow of Leicestershire undertaken by R.F. 

Hartley in the 1980s and derived from earlier aerial photographs, shows ridge and furrow 

aligned roughly south-west to north-east, north to south, and west to east across the site 

(Figure 3). 

 

 

Figure 3: R. F Hartley’s ridge and furrow survey map of Higham, with assessment area 

highlighted. 

Geophysical Survey and trial trench evaluation 

 

A geophysical survey was undertaken for CgMs Consulting (Richardson 2013). The survey at 

Higham on the Hill corroborates the findings of the desk-based assessment (Clarke 2012; 

Clarke and Clay 2013) and field evaluation (Hyam 2012), with the only probable 

archaeological anomalies being related to ridge and furrow cultivation (Figure 4).  Five 20m 

evaluation trenches were excavated across the central field none of which revealed any evidence 

of archaeological features or deposits (Hyam 2012). 
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Figure 4: Interpretation of gradiometer anomalies from the geophysical survey (From 

Richardson 2013, Fig. 5) 

Aim of the Survey 

The overall aim of the survey was to accurately record the visible ridge and furrow that will 

be destroyed by the development and to put it into the context of other surviving ridge and 

furrow in the immediate vicinity. 

Methodology 

The Written Scheme of Investigation (WSI ULAS 2014) suggested a survey using a Topcon 

Hyper V Global Positioning System (GPS). This can provide resolution to an accuracy of 

10mm. The changes in level of all the earthworks and sections across the earthworks were to 

be recorded. However following a site visit on 10.09.2014 and discussion with the ULAS 

LiDAR specialist it was clear that better resolution and greater accuracy could be obtained 

across a wider area by the analysis of LiDAR data that was available from the Environment 

Agency. 

Provision of LiDAR Data 

Composite aerial LiDAR data at 1m resolution was supplied electronically in ASCII file 

format by National Geomatics Unit of the Environment Agency. The data was flown between 

2011 and 2013: details of the data source are given below (p16). The data was acquired in 

DTM format, that has been filtered, where possible, to remove obstructions such as buildings 

and vegetation and provide a 'bare-earth' model. If the removal of said obstruction left a gap 

in the surface data this gap was interpolated by the EA (using an undisclosed algorithm) to 
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provide a continuous surface. 

 

The methodology used followed that set out by Hannon (Hannon et al 2014, 8). 

LiDAR ASCII Data Processing 

Unless otherwise stated, all operations were conducted in Esri ArcMap10.1 SP1 build 3143. 

Each of these files were imported into ArcGIS using the ASCII to Raster function (System 

Toolboxes>Conversion Tools>To Raster>ASCII to Raster), the output data type was set to 

‘Float’ and the original ASCII filename was retained as the output raster name. These files 

were placed in a newly created file geodatabase called ‘15501_HighamontheHill.gdb’.  

The two individual files were combined to form one continuous raster using the Mosaic To 

New Raster Function (System Toolboxes> Data Management Tools>Raster>Raster 

Dataset>Mosaic To New Raster) using 'British National Grid' as the spatial reference, with 

the pixel type set to '32_BIT_FLOAT', number of bands set to '1' and the cellsize set to mirror 

the resolution of the input rasters (i.e. 1). The resulting raster was saved to the same file 

geodatabase.  

Creation of Hillshade layers 

To aid feature identification, four basic hillshade layers were generated for each LiDAR 

flight.  ‘Hillshades’ are a data processing method available in most GIS which allow an 

artificial sun to be shone from any chosen compass bearing and from angle above the horizon 

onto a DEM. This process helps identify ground features by casting an artificial shadow 

behind changes in elevation (for a full discussion of the process see Bewley et al 2005). 

Each of these layers were created using the hillshade function (System Toolboxes>Spatial 

Analyst Tools>Surface>Hillshade). The input raster for each hillshade was the mosaicked 

DEM or the Clipped DEM if one was generated, for each LiDAR flight. Three basic 

parameters were utilised to generate the four different hillshade views and Z factor relating to 

the degree of exaggeration applied to the input DEM, with 1 indicating no exaggeration. 

Each output raster was named to preserve the original input DEM information and include the 

hillshade parameters (e.g.‘HH_1m_HS_315_45_1’) and saved to 

‘15501_HighamontheHill.gdb’. Once each hillshade was generated they were grouped within 

the TOC to aid navigation. 

Sky-View Factor Analysis 

‘Sky-View Factor’ (SVF) analysis was also applied to the LiDAR data (Zakšek et al 2011). 

This method, instead of applying false shadows to a surface, calculates the volume of sky 

visible from a given position, a position at the bottom of a ditch affords a lower level of 

visibility to one atop a mound. This method produces a raster layer showing the volume of 

sky visible from each position within the raster which can highlight subtle archaeological 

features. SVF is not a function available in ArcMap, therefore a free to use version of the tool 

is available online (http://iaps.zrc-sazu.si/index.php?q=en/svf). 

To utilise the tool the DEM for the area was exported as a TIFF. This was achieved by right-

clicking on the DEM layer within the TOC (Data>Export Data) selecting a destination for the 

TIFF file and leaving all other parameters at default. Once the TIFF had been exported the 

SVF tool was run. The exported TIFF was used as the input DEM and Search Radius was left 

http://iaps.zrc-sazu.si/index.php?q=en/svf
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at the default 10. The Vertical exaggeration was set to either 1, 2 or 3 and Direction set to 

either 16 or 32, multiple Sky-Views were run for each focus area using a range of values. The 

tool created an output TIFF file which reflected the name of the input DEM and settings used 

(e.g. ‘LiDAR_1m_SVF_d32_r10_ve3’). This TIFF was then imported into ArcMap and 

added to the TOC. 

The SVF images were then also interrogated and potential features recorded in the same 

manner as is detailed above for the initial feature identification process. 

Feature Identification 

The hillshade layers that had been generated were systematically analysed for potential 

archaeological features, working from north to south and west to east. This was achieved by 

cycling through each of the hillshade and Sky View Factor layers individually. The shapefile 

layers containing both the HER and scheduled monument data were enabled to prevent re-

identification of an already recorded archaeological feature.  

Once the areas of ridge and furrow within the study area had been identified as part of the 

LiDAR analysis, the hillshade plots that contained the clearest representations of the different 

elements were combined using varying transparencies to produce figures contained in this 

report. 

Profiles 

Profiles were generated with ARCGIS from the DTM data using the 3d Analyst tool, 

Interpolate line, choosing the profile line and Profile Graph options. The profiles are 

presented individually (Figure 6-Figure 8) and together at uniform scale (Figure 9). 

 

Images were processed in Standard Raster image and CAD packages. 

Results 

Ridge and furrow is the product of ploughing strip-shaped plots using a non-reversible 

plough in a clockwise manner. The mould board turned the soil into the centre creating a self-

draining ridge. This form of topography seems to be normally associated with common fields 

systems although such systems did not invariably have ridge and furrow in all regions. 

Common fields seem to have originated by the late Saxon period. They comprised strips of 

land scattered throughout the furlongs and fields giving equal shares of good and bad land. 

Such fields in the East Midlands normally had a three or four field system by which part of 

the land was left fallow on a rotating basis. They reached their maximum extent with the 

population rise of the 13th century. The East Midlands was a classic common field landscape 

in the Middle Ages and has particularly good survival of ridge and furrow. This reflects the 

move to sheep farming in the century after the Black Death followed by a concentration on 

livestock production in many parishes, particularly on poorer soils, which continued to the 

present day. Ploughing, for instance, to improve grassland has contributed to widespread 

destruction since WWII (Hall 1982; 1988; Roberts and Wrathmell 2000).  

 

Leicestershire still had extensive surviving areas of ridge and furrow in the late 1940s when 

the RAF undertook vertical air surveys. This extent has been plotted by Leicestershire County 
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Council and published for many areas by Fred Hartley in a series of volumes on the county’s 

earthworks. Higham on the Hill is included in Hartley 2008, Map 13.  

In the late 1990s, English Heritage sponsored a survey of surviving ridge and furrow in the 

Midlands: Leicestershire, Northamptonshire, Rutland, Cambridgeshire, Bedfordshire, 

Buckinghamshire and Oxfordshire. This indicated widespread destruction of open fields over 

the last half century. The survey also listed 43 townships with significant surviving areas of 

ridge and furrow. Of these, nine were in Leicestershire: Owston and Newbold, Hungarton, 

Hallaton, Welham, Thorpe Langton, Saddington, Mowsley and Gumley (Anderton and Went 

2002; Hall 2001). 
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Figure 5: Composite hillshade plot of LiDAR 1m DTM data 

Contains Ordnance Survey data © Crown copyright and database right 2014. Development area mapping (supplied). 

LiDAR Source – Environment Agency 
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Figure 6: Composite hillshade plot. Profile 1 
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Development area mapping (supplied).  

LiDAR Source – Environment Agency 

 

 

Figure 7: Composite hillshade plot. Profile 2 
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Development area mapping (supplied).  

LiDAR Source – Environment Agency 

 

 

Figure 8: Composite hillshade plot. Profile 3 

Development area mapping (supplied). 

LiDAR Source – Environment Agency 



An archaeological earthwork survey by LiDAR study for land off Station Road, Hilary Bevins Close and Main 

Street, Higham on the Hill, Leicestershire (SP 379 956). 

 

12 
© ULAS Report 2014-162 Accession Number X.A114.2012 

 

Figure 9: Combined profiles with dimensions at uniform scale (vertical exaggeration x10). 

 

Figure 10:  Northernmost field looking north 
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Figure 11: Central field, looking north-west 

 

 

 

Figure 12: Southernmost field viewed from the south 
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The ridge and furrow at Higham on the Hill shows two distinct types. The northern and 

southern fields comprise wider spaced systems 8 to 9 metres apart aligned east-north-east to 

west-south-west in the southern field and north-east to south-west in the northern field. The 

central field has ridge and furrow aligned north-west to south-east 4 to 5 metres apart, the 

northern extent of which extends into the south-eastern part of the northern field (Figure 5, 

Figure 7).  This last area is particularly denuded, and in many of the shade plots was not 

visible at all.  

 

It is possible that the central field with its narrower system my pre-date the wider system. The 

fields form part of a wider system of surviving ridge and furrow being part of the open fields 

to the north-west of the village (Figure 5).  

 

The linear feature crossing north-west to south-east in the northern most field was identified 

in the geophysical survey and represents a former footpath that survived until at least 1973 

(Richardson 2013, 6) and is shown on the 1
st
 edition Ordnance Survey (Clarke and Clay 

2013, 9). 

 

The wide feature crossing west southwest to east northeast that truncates the ridge and furrow 

in the northernmost field is clearly identified as a service in the geophysical survey 

(Richardson 2013, 6). The feature is visible in the 1945/6 vertical imagery made available 

through GoogleEarth, and is possibly related to the ‘Works’ which appear to east of the 

proposed area between the 1924 and 1961 maps (Clarke and Clay 2013, 12-13).  

Archive 

The archive will be deposited as part of X.A114.2012 and consists of: 

This report, 

CD of digital data and photographs.  

1 GIS project in mxd format containing the layers created for the analysis. 

 

The EA LiDAR data and images derived from that data have been used under Licence from 

the EA, and are not included in an archive deposition. 
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Appendix: LiDAR metadata  

FILENAME TILENAME DATE_FLOWN %_COVERAGE POLYGON_ID RESOLUTION 

(m) 

D0141101 SP3694  12 Feb 2011 13.23 P_7458 1 

D0141105 SP3894  12 Feb 2011 51.92 P_7458 1 

D0148349 SP3694  17 Nov 2011 20.52 P_8014 1 

D0148353 SP3894  17 Nov 2011 71.5 P_8014 1 

D0161114 SP3694  4- 6 Feb 2013 99.86 P_8705 1 

D0161128 SP3894  4- 6 Feb 2013 99.31 P_8705 1 

Source of composite data used in the LiDAR analysis. 
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